In this Exercise:

- The Basic Map
- The Layout View – Adding Map Elements
- Notes on Finishing the Map
- Printing and Exporting the Map
- Creating a Mapping Application in QGIS Cloud
- Online Resources: Cartography

The Basic Map

In Exercise 1, we used the online Interactive Map Viewer to view geographic data and create a map.

The map included the map image as well as a Title, Map Legend, North Arrow, Scale Bar, and descriptive text.
Maps should include some combination of these elements so that output may clearly relate the intended information to the anticipated audience.

The Print Composer – Adding Map Elements

Opening the Print Composer provides you with a blank canvas to which you can add the current QGIS map canvas, legend, scalebar, images, basic shapes, arrows and text. The print composer provides three tabs:

- The **Composition** tab allows you to set paper size, orientation, the print quality for the output file in dpi and to activate snapping to a grid of a defined resolution. Please note, the Snap to grid feature only works, if you define a grid resolution > 0. Furthermore you can also activate the Print as raster checkbox. This means all elements will be rastered before printing or saving as Postscript of PDF.

- The **Item Properties** tab displays the properties for the selected map element. Click the Select/Move item icon to select an element (e.g. legend, scalebar or label) on the canvas. Then click the Item tab and customize the settings for the selected element.

- The **Atlas Generation** tab allows you to generate an atlas. Read the user manual for more information on this function.

You can add multiple elements (or Items) to the composer. It is also possible to have more than one map view or legend or scalebar in the print composer canvas. Each element has its own properties and in the case of the map, its own extent. If you want to remove an element from the composer canvas you simply choose it and click the delete or backspace key.

1. **Opening The Print Composer**

   a) Open QGIS and the project file `ch5exercise.qgs`, or another project you have created.

   b) Click on the "New Print Composer" button on the tool bar
c) Set your composition properties first, especially page size and orientation. For this exercise I would suggest choosing a portrait orientation letter-sized page.

d) At first, the window has only a blank canvas, because we need to add all of the elements. Hold your cursor over each icon/button to see what it does.

e) To add the map canvas, click on the "Add new map" button in the print composer toolbar and drag a rectangle on the composer canvas with the left mouse button to add the map. To display the current map, you can choose between three different modes in the map Item Properties tab:

i.  *Preview Rectangle* only displays an empty box with a message "Map will be printed here".

ii. *Preview Cache* renders the map in the current screen resolution. When you zoom in or out within the composer window, the map is not rendered again but the image will be scaled.
iii. *Preview Render* means that if you zoom in or out within the composer window, the map will be rendered again, but for space reasons, only up to a maximum resolution.

![Image showing composer window with map properties]

f) You can resize the map element by clicking on the "Select/Move item" icon (blue arrow), selecting the element, and dragging one of the blue handles in the corner of the map. With the map selected, you can now change more properties in the map Item tab. To move the map image within the map element, select the map element, click the "Move item content" icon (green box with arrow) and move the layers within the map element frame with the left mouse button. Make sure to change back to the “Select/Move item” icon when you are done!

![Image showing how to move map content]

![Image showing select/move item]

g) In order to control how your map fills the map element, you can change the Width, Height, or Scale in the Map section of the Item tab (when the map element is chosen). Change the Scale of your map element to 1,000,000 (meaning 1:1,000,000), or whatever makes your map fill most of the map element box. You may need to adjust this if you resize your map element.
2. Adding Elements - Title

a) Besides adding a map canvas to the Print Composer, it is also possible to add, position, move and customize legend, scalebar, images and label (title and other text) elements. Each of these elements can be added with the corresponding button on the tool bar or from the "Layout" menu.

b) Add a title to your map by clicking on the "Add new label" button and notice that the Item Properties tab on the right immediately provides a place to type in the text, change font, colors, alignment, etc. You can also turn off the frame around the label box. Make it look nice!

c) You can re-position the title by putting your cursor over it anywhere other than an edge. When your cursor is over a corner, it can resize the box.

3. Adding a Scale Bar

a) Click on the word Layout on the tool bar to open the Layout menu. You will see the many options that exist for adding elements to your map. Click on "Add scale bar."
b) Click anywhere on the map to place the scale bar and then adjust settings in the Item tab on the right. Note that you can change units, number of segments, style of bar, as well as whether you have a border and background.

4. Adding a Legend

a) Click on the Map Element in the Layout.

b) Click on the "Add new legend" button in the toolbar.

c) Click anywhere on the map to place the default legend.
A Legend is one of the most critical map elements because it describes the data the viewer will see on the map. Labels and symbols should be designed to be clear and easily understood by the intended audience, so plan to spend some time editing your legend in order to make it as clear and useful as possible.

d) You might want to consider going back to your main QGIS window at this point to rename the data layers you anticipate keeping in the legend in your compositions. Right now, there is a dynamic relationship between your project and your composition legend. You may want to break that dynamic relationship for design reasons, but you can give your layers more easily understood names once and even if you need to redo your legend you won’t have to re-type the layer names. An example would be right clicking on Boundary_TWNBNDS_poly and renaming it to Town Boundaries.

e) If turn off the Auto Update option (the live link between the legend and your map project) you can change the order of legend elements in the "Legend Items" section of the Item Properties tab on the right. You can also edit the names of the various legend elements, and remove layers (from the legend) if necessary. If you remove layers and then realize you want them back, you can simply click on the plus sign button to add back in whatever layer you wish.

f) Try editing the various aspects of the legend using the sections and options in the Item Properties tab.
Notes on Finishing the Map

Creating a clear and visually appealing map depends on many items including the elements discussed in the steps above.

Adding more text is typically necessary and should at minimum include information about who created the map and the date.

The map should include elements at an appropriate scale so that text and map features are clearly visible without being too large or too small. The appropriate scale is entirely dependent on how the map will be used: web image, image in a report, wall poster, powerpoint image, etc.

The map should make use of the visible space in a layout where elements are well spaced on the page.

Printing and Exporting the Map

Printing and/or Exporting the map as it appears in the Print Composer is the final step.

1. Printing

   a) To Print click on the menu to select:

      Composer

      ➔ Print

   b) Or, use the print button in the toolbar

   c) In the Print window select options that define the printer and page settings
2. Exporting

a) Your export options include export to PDF, export to SVG, and export to image. You can access these options from the Composer menu or via the buttons on the tool bar.

b) If you choose "Export as image" the "Save map image as" window appears asking you where you would like to save it, what name you would like to give it, and what format you would like to save to.

NOTE: Set your export resolution in the Composition tab of your composition. 300 dpi is usually appropriate if you are printing. If you are creating an image that will be posted on a website, you might want to consider 150 dpi or less.

c) Click "save" once you have filled in the relevant information in your “Save map image as” window.
Creating a Mapping Application in QGIS Cloud

You can publish your map as a dynamic online application! First you must create a QGIS cloud account at [http://qgiscloud.com](http://qgiscloud.com) (they range in price between free and ~$70/month).

You also have to install the QGIS Cloud plugin in your QGIS desktop software. Click on the Plugins Menu, choose “manage and install plugins” and find QGIS Cloud in the list.

Once the QGIS Cloud plugin is installed, turn it on if it doesn’t turn on automatically!

You will need to sign in to your account (click on the account tab found in the QGIS Cloud plugin panel). This will allow you to take any QGIS map project that you create and publish it to QGIS cloud.

A few important tips:

1. VCGI’s shapefile data seems to give QGIS Cloud indigestion! There is an issue with how QGIS is interpreting the coordinate system of our data. This prevents you from being able to upload file data you have stored on your computer or server into QGIS cloud so that it can be used in the cloud version of your map.

2. A workaround is to use map services – from any source, including QGIS (note that the QGIS Cloud plugin has an “add background layer” option – and it offers some nice options once you install the Open Layers plugin).

3. Another workaround is to bring whatever data and services you want to use into your project, but before doing too much with symbology and labelling, perform a “save as” on each of your shapefiles and save them as GeoJson files. This seems
to eliminate the problem. Then work on your symbology and labelling, and upload these files when you are ready to publish your map.

Let’s practice creating an online map in QGIS using some map services from VCGI and the Airport layer.

1. Bring in an imagery service as well as the airports layer (see chapter 6 for a reminder of how to bring in an imagery service from VCGI).
2. Next, “save as” GeoJSON:
   a. Simply Right click on the airports layer, then choose “Save As”
   b. Set the format to GeoJSON
   c. Browse to where you would like to save your new file and name it.
   d. Click on “OK”
3. Now you can remove the shapefile and adjust the symbology and labelling on your GeoJSON file (see chapter 7).

4. In order to start the process of publishing to QGIS Cloud, you must sign in to your QGIS Cloud account within QGIS.

5. Next, click on the Upload Data tab and upload your local data (anything that is on a local drive or limited access server, as opposed to a public map or feature service) to a database that is created for you in your QGIS Cloud account: in this case, the airport layer.

**NOTE:** once the data is uploaded, the project replaces the reference to your local data with a reference to the uploaded data (it is essentially treated as another map service). You are given the option to either overwrite your existing project, or give it a new name. This allows you to retain the project with local references and create a new project that references the cloud data if you choose.
6. Now you can “publish” your map by clicking the “publish” button in the Map tab and once it is published you will be given links to various versions of your new online maps (desktop and mobile):

7. Check out your online map by clicking the webmap link:
You might wonder if you have more control over how your online map is presented once it is published. The short answer is not really, but you do have a few ways to control the interface.

One simply involves setting zoom levels at which users can view your map. If you set these, the levels you set are the only ones people will be able to view your map at. You set these levels by clicking on the “map admin” link in your QGIS Plugin window in your desktop project:

1. Login to your account, then click on the edit icon to the right of your online map:

2. Scroll down a bit and you will see a blank setting for “Scales.” Simply fill in some scales, separating them with commas, and those will be the only scales at which the map can be viewed. In the example below, I have limited the scales to 1:1,000,000 or 1:200,000 or 1:5,000. Click “update Map” when you are done.
3. Another way you can control your map is to save a “composition” in the map composer in your QGIS Desktop project, as described at the beginning of this chapter. This will give your users the option to Print from your online map using the layout you have created. In this case, “print” really means create a PDF that you can then print or save. For some reason, QGIS Cloud limits the scales at which you can create that PDF, with the smallest scale being 1:50,000.
4. Save your map and publish it again in order to effect this change in your QGIS Cloud map.
5. Once your map is published, you can share it with anyone.
Online Resources: Cartography

For more information about cartography and map design download the document “Introduction to Map Design” (in Adobe PDF format) from the ESRI website: www.esri.com/industries/k-12/download/docs/intrcart.pdf

You can find a lot of support online from other QGIS users regarding cartography and design. A couple of examples are these Flickr Galleries:

https://www.flickr.com/groups/qgis-screenshots/
https://www.flickr.com/groups/qgis/pool